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Wsparcie techniczne
Jesli masz problemy z uzytkowaniem Edytor audio WavePad przed skontaktowaniem sie z 
dzialem wsparcia technicznego zapoznaj sie z zawartoscia tego pliku. Jesli nie znajdziesz tutaj 
rozwiazania swojego problemu to zapoznaj sie z codziennie aktualizowanym systemem 
pomocy Edytor audio WavePad Online Wsparcie techniczne 

www.nch.com.au/wavepad/pl/support.html . 
Jesli to rowniez nie rozwiaze problemu skontaktuj sie z centrum pomocy technicznej.
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Uaktualnienie do wavepad master's Edition
Wiele profesjonalnych narz
To view pricing and to purchase an upgrade to WavePad Master's Edition please open 
https://secure.nch.com.au/cgi-bin/register.exe?software=wavepad. 
Po zakupie i aktywacji licencji otrzymasz rejestracj
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Pakiet oprogramowania NCH
Jest to przydatny sposób przegl
Mo
Istnieje równie
Szukaj
Przeszukaj nasz
Zobacz wi
Przegl
Zapisz si
Mo
Zobacz najnowsze rabaty na zakup
Zobacz najnowsze rabaty, które oferujemy przy zakupie naszych produktów.
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Opcje kodera Opus
Kodowanie d
Szybko
Docelowa szybko
U
W trybie domy
U
W trybie VBR szybko
U
Dane wyj
U
Z hard-cbr ka
Mieszanka w dó
Nie wy
Downmix do mono
Wymuszenie downmix do mono.
Downmix do stereo
Downmix do stereo, je
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Postanowienia licencyjne dotycz
Naszym celem jest, aby ka
UMOWA LICENCYJNA U
Niniejsza umowa licencyjna ogranicza nasz
1. Prawa autorskie do tego oprogramowania oraz wszelkie dzie
2. Instaluj
3. To oprogramowanie oraz wszystkie towarzysz
4. Nie ponosimy odpowiedzialno
5. U
6. U
7. Korzystanie z danych gromadzonych przez oprogramowanie podlega O
8. Wybór prawa. Je
9. Tylko klienci z USA: Umowa arbitra
Je
Strona, która zamierza ubiega
Dzia
NCH Software, Inc.
6120 Greenwood Plaza Blvd, Ste 120
Greenwood Village CO, 80111
Stany Zjednoczone Ameryki
("Adres powiadomienia"). Zawiadomienie musi (a) opisywa
A. Arbitra
B. Arbiter mo
C. Niezale
D. Aby zrezygnowa
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Proces autoryzacji Google w systemach Windows 
XP i Vista
Aby przekaza
1. KliknijAutoryzowa  w {Autoryzacja}  AutoryzacjiOkno dialogowe.
2. W przypadku otwarcia strony internetowej zaloguj si
3. Upewnij si
4. SkopiujKod autoryzacjiprzez Google i wklej go wPotwierdzenie autoryzacjiokno 

dialogowe w WavePad.
5. KliknijGotowyaby potwierdzi
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Podstawy - Przegl
WavePad to program do edytora d
WavePad zosta
WavePad Basic Edition jest bezp
https://secure.nch.com.au/cgi-bin/register.exe?software=wavepad . 
Funkcje
● Obs
● Szeroki zakres funkcji edycji, w tym Wytnij, Kopiuj, Wklej, Usu
● Efekty, w tym Wzmocnienie, Normalizacja, Korektor, Koperta, Pog
● Widok spektrogramu cz
● Efekt d
● Edytor d
● Obs
● Mo
● Zawiera ripper CD do 
● Odtwarzacz zawiera kontrol
● Rejestrator obs
● Obs
● Obs
● Obs
● Pe
Wymagania systemowe
● Windows XP/Vista/7/8/10
WavePad jest tylko jednym z elementów pakietu NCH Software oprogramowania audio, wideo 
i oprogramowania biznesowego. Jewww.nch.com.au, aby pobra
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Podstawy - Ogólne poj
Jest to ogólne wprowadzenie do kluczowych koncepcji audio dla tych, którzy wcze
D
Punktem wyj

Cz
Jednym ze sposobów analizy d
CzAnaliza cz  aby uzyska
Mówi si
G
Terminy g
Podczas regulacji poziomu g
Ludzkie ucho mo
Nagrywanie d
Aby przechowywa

Cz
Cz
Mo
Krótki przewodnik po cenach próbek jest nast
● 6000 - Bardzo niskiej jako
● 8000 - Telefon jako
● 11025 - Rozs
● 22050 - Dobrej jako
● 44100 - Jako
Wy
Wskazówka:  zawsze nagrywaj i pracuj z d
Kana
Wiele "kana
Wskazówka:  Je
8/16/24/32 bity
By

Kompresja plików audio i kodeki
Jednym z problemów z wysokiej jako
Istnieje wiele ró
Koder-dekodownik kompresji mo
Kompresji plików audio nie naleEfekty .
Edycja i efekty
Edycja oznacza usuwanie lub wstawianie d
Zobacz menu Edycja i Efekty wavepada. KaEfekty .
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Podstawy - Podstawy WavePad
Gra
To play from the current position press F9 . 

Zagraj ponownie
To repeat playing a file from the same cursor position press CTRL+Space . 

Rekord
To record (at the current position or over the selected region) press the F5 key . 

Poruszanie si
To go to the beginning press the Home key or press the End key to move to the end. To 
rewind press and hold down the left arrow key and to fast-forward press the right arrow key. 
Mo
Peeling
To find accurate edit positions with your ears press F6 to activate scrub . This allows much 
finer movement (with the arrow keys) while listening to the point you want to edit. 

Wybieranie regionów
Before you can apply some effects or edit functions you need to select the region to edit or 
apply the effect to. Press %CTRL%A to select the entire file. To select with the mouse click on 
the wave window and drag over the part you want to select. 
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Podstawy - Odwo
Ekran g
Na ekranie gGórne okno wyokno  pokazuje przebieg d
Menu - Zawiera wszystkie dzia
Karty - Zorganizuj funkcje WavePada na kartach, aby usprawni
Pasek polece  — zawiera 
Przyciski powi
A. Pomniejsz  - Kliknij ten przycisk, aby pomniejszy
B. Powi  - Kliknij ten przycisk, aby powi
C. Poka — kliknij ten przycisk, aby pomniejszy
D. Powi  - Kliknij ten przycisk, aby powi
E. Powi - Kliknij ten przycisk, aby zwi
Istnieje równie
Opcje widoku
F. Tryb edycji próbki  — umo
G. Display + w gór  - To 
H. Wy  - Wy
I. Wy - lewe i prawe kana
J. Oddzielna edycja kana  — umo
K. Spektogram cz  — poka
L. Spektogram cz  - Poka
M. Wy  - Poka
Informacje o wyborze fali
Informacje o wybranym regionie fali. Na powy
Start — pozycja pocz
Koniec  — po
D  — d
D  — d
Suwak d
O. Suwak d  - Dostosuj g
P. Ustawienia miksera d
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Podstawy - Cofanie i ponawianie
Cofnij(Ctrl+2Z) 
To Undo is to restore the file to its state before the previous edit function. This is useful if you 
want to try an edit or just make a mistake. To undo your last action press %CTRL%Z . 
Uwaga: Mo
Ponów(Ctrl+Y) 
Je
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Podstawy - Praca z plikami
Tworzenie nowego pliku audio
To create a new file press %CTRL%N. 
Podczas tworzenia nowego pliku WavePad wywavepada Options.
Aby uzyskaOgólne poj .
Otwieranie istniej
Aby otworzy
You can also load audio tracks from the CDs by select File -> Load Audio CD Track(s). Select 
a track by click on it or hold down the Ctrl key for selecting multiple tracks.
Zapisywanie pliku audio
To save the current audio file with the current name press %CTRL%S. 
Zobacz us uzyska
Aby zapisa
Uwaga: Podczas pracy z plikami audio nie nale
Aby uzyskaFormaty wyj

Kopiowanie plików na dysk CD
Wybranie tej opcji pozwoli nagranagrywarki CD Express Burn równie

Wysy
WavePad allows you to send the file by either email or direct internet connection. You can 
select how to send a file by using the menu File->Send. 

Adres e-mail
Je

Wprowad

Poczta e-mail — ustawienia
Domy

Je
Je

Bezpo
WavePad mo

Wybierz opcj
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Podstawy - Nagrywania
Nagrywania
Aby rozpocz
Aby dostosowapozycji Options > Recording, w którym mo
Cz b
Liczba kanaMono , dwa dla Stereo)b
Po rozpoczwstrzyma . Nastwznowi naciskaj
Wskazówki dotycz
● Rozmieszczenie mikrofonu! Trzymaj mikrofon z dala od wentylatorów komputerowych/ ha
● Wykonaj nagrywanie testowe przed rozpocz
● Nagrywaj swój g
● Tylko Normalizuj raz, po dodaniu wszystkich edycji i efektów
Overdub / Mix Nagrywanie
(Uwaga:Zalecamy wypróbowanie mixpada, aby nagra
Aby nagra
Je
Nagrywanie aktywowane g
Nagrywanie aktywowane g
The Silence Threshold can be set in WavePad Options on the Recording tab. On this tab, in 
the section Automatic Recording, you can select Voice Activated Recording, Set the delay in 
seconds before recording is deactivated when silence is detected and set the Silence 
Threshold. We recommend starting with the default settings to test your recording 
environment. Depending on the level of background noise and the sensitivity of your 
microphone, you will need to increase or decrease the Silence Threshold. You want the 
Silence Threshold to be high enough that it does not record only background noise, but low 
enough that it will always start recording when you begin speaking.
Stan gotowo
Przycisk Poziomy na karcie Nagrywania powoduje umieszczanie rekordu w trybie gotowo
Na wy
Gdy b
Aby uzyskaWavePad Zalecane mikrofony.

S
Aby w
W systemie Windows 7 lub wy
1. Otwórz ustawienia nagrywania komputera. (MoWindows+R, aby otworzymmsys.cpl . Po wy

2. Kliknij prawym przyciskiem myszy mikrofon i wybierz w.
3. Wybierz kartS
4. Zaznacz pole wyboru obok pozycji S.
5. Kliknij przycisk Zastosuj
W systemach Windows XP i Vista:
1. Otwórz ustawienia woluminu dla komputera. (MoWindows+R, aby otworzysndvol32.exe)
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2. W 
przypadku opcji Mikrofon / Line In / Input Monitor,odznacz wyciszenie i ustaw g

(JeOpcje  i wybierz polecenie W. Wybierz pozycj i upewnij si

17



18



Podstawy - Widok spektrogramu cz
Widok spektrogramu cz
● Wizualizuj cz
● Szybkie przechodzenie do punktu zainteresowania,
● Analizowanie zawarto
● Wybierz zakres cz

● Odtwarzanie, aby us
● Wycinanie, kopiowanie, wklejanie lub usuwanie,
● Zastosuj efekty do, lub
● S

Widok spektrogramu mo
Po w
Zobacz tak
● Narz, takich jak okna FFT i TFFT. Widok Spektrogram cz
● Mieszanie pasty , do wklejania izolowanego d
● Ruch i wybór
● Wycinanie, kopiowanie i wklejanie
● Efekty
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Podstawy - Zak
Zak
Zak
Aby dodai wprowadaby otworzy
Aby wybra
Zak
Regionów
Regiony przechowuj
Aby dodai nadaj mu nazwi umyszy, aby odtworzy
Regiony mog
Regiony nie sPraca z projektami WavePad).
Kopiowanie regionów na dysk CD
Ta opcja w systemie Windows XP umo
Je
Uwaga: Ta opcja b.
Eksportowanie regionów do folderu
Ta opcja umo jeden lub wi

Narz
To narz
Po dodaniu wszystkich chwytów zainteresowania, gdy regiony otwieraj
Domy

20

projects.html


Podstawy - Projekty WavePad
Projekt WavePad to wszystkie otwarte pliki i lista regionów przechowywana w doskona
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Podstawy - Odwo
Operacje na plikach
● Tworzenie nowego pliku (nowa karta)11111CTRL%2N  
● Tworzenie nowego pliku (nowe okno)11111CLECZDLASHIFT%2N  
● Otwórz plik 11111CTRL%2O 
● Zapisz plik 11111CTRL%2S 
● Zapisz plik jako %T 
● Zamknij plik11111CTRL%2WW 
● Zamknij okno pliku z kartami Ctrl+F4  
● Opcje 11111CTRLSHIFT%2OO 
● PokaAlt 
Operacje odtwarzania
● Rekord F5 (w
● Nagrywanie z aktywacjShift+F25
● Nagrywanie ze trybem gotowoAlt+F5
● Nagrywanie ponownie11111CTRL%F25
● Overdub / Mix Nagrywanie 11111CLECZSHIFT%F25
● GraF9/Spacja
● Odtwarzanie/pauzaSpacji
● Graj z powolnF11
● Graj normalnF10 ( F10 )
● Graj z duF12 ( F12 )
● Powtórz odtwarzanie11111CTRL%F9
● Zagraj ponownie 11111CTRL%2 Pasek przestrzeni
● Czyszczenie lub wstrzymanie/wznowienie nagrywaniaF6 (w
● ZatrzymaEsc/Spacja/Pauza
● PrzewiLeft2
● Przewij do przoduRight22
Przenoszenie i wybieranie operacji
Uwaga: przytrzymaj klawisz shift, aby wybra
● PrzejdW: strona g
● Przejd Ko 
● PrzejdAlt+Doma g
● PrzejdAlt+Od
● Strona do przoduStrona w dó
● Strona wsteczStrona w gór
● Nast11111CTRLRIGHTARROW%22
● Poprzedni punkt ci11111CTRLLEFTARROW%2
● Cal do przodu11111CTRLALTRIGHTARROW%2
● Cal wstecz11111CTRLALTLEFTARROW%
● Dobra przód%ALTRIGHTARROW%22
● Drobny powrót%ALTLEFTARROW%2
● Wybierz wszystkie11111CTRL%A2
● Wybierz opcj11111CTRLALT%A22
● Wybierz okre11111CTRL%G2
● Przejd11111CTRL%L2
● Znajdowanie i wybieranie próbki szczytowej%T
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● Wybierz, aby rozpoczShift+Home
● Wybierz do koShift+E22ND
● Zaznacz pierwsz11111CTRL%12
● Zaznacz drug11111CTRL%22
● Przywo11111CTRLALT%222
● Kopiowanie, przeci11111CTRL%Drag
● Wytnij, przeci11111CTRLSHIFT%2Drag
Uwaga: Aby przeci
Edytuj operacje
● Cofnij11111CTRL%2ZZ
● PonówCtrl+Y2
● Ci11111CTRL%X2
● Kopiowanie (lub cykl kopiowania)11111CTRL%2C
● Kopiowanie do schowka systemowego11111CTRLSHIFT%2C
● Wklej11111CTRL%2V
● Cykl wklejaniaShift+2V
● Wklej ze schowka systemu%T
● Mieszanie pasty 11111CTRLALT%2V
● Usun11111DELETEKEY%22
● Split %SZTSHIFT%22D
● Sprz11111CTRL%J2
● Zduplikowane 11111CTRL%2DD
● Kopiuj do nowego 11111CTRLSHIFT%2C
● Redact/Beep 11111CTRLALT%2B
● P%ZMISJARL%82
● Ciszy 11111CTRL%02
● Edytuj przyk11111CTRL%I2
● Przycinanie 11111CTRL%2T
● Przytnij pocz11111TRIMSTART%22
● Koniec przyci11111TRIMEND%2
Operacje powi
● Powi%T
● Pomniejszenie11111CTRL%-2
● Powi%ZMISJARL%F2
● Powi%T
● Powi%T
● Pomniejszenie w pionie11111CTRLALT%-22
● Domy11111CTRLALTSHIFT%F2
Zak
● Dodawanie zak11111CTRL%2B
● Szybka zakB
● Otwórz list11111CTRLSHIFT%2B
● Dodaj region11111CTRL%2R
● Otwórz list11111CTRLSHIFT%2R
● PrzejdAlt+2R
● PrzejdAlt+L2
Operacje zanikania
● Auto zanikanieAlt+A2
● ZanikanieAlt+I2
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● ZanikanieAlt+2O
● Zanikanie i przycinanieAlt+J2
● Zanikanie i przycinanieAlt+K
● Wybór crossfadeAlt+C
● Crossfade do innego klipuAlt+X2
● PAlt+2Z
Pomoc
● ZawartoF1 ( F1 )
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Podstawy - Kreatorzy szybkiego startu
Kreatorzy szybkiego startu to grupa wprowadzanych z przewodnikiem do prostych, typowych 
zadaPoka Je
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Podstawy - Us
Otwórz z chmury
WavePad allows you to open files from Dropbox, Google Drive, OneDrive or SoundCloud. 
Dropbox, OneDrive and Google Drive are cloud-based storage services that let you upload, 
store, access and share your files from anywhere. For Dropbox the first 2 GB, for OneDrive the 
first 5 GB and for Google Drive the first 15 GB of storage are free, but additional storage 
packages are available for a monthly fee. 
SoundCloud to internetowa platforma dystrybucji i streamingu audio online. SoundCloud 
pozwala u
Aby skonfigurowa
Using 'Download file from Cloud Service...' option under the 'File' menu of WavePad, you can 
choose one of the above cloud services. After authenticating with your account, you will be 
able to navigate through the folders to select the desired file and open it in WavePad. It should 
be noted that Dropbox only allows you to use the 'Apps\WavePad' folder with WavePad. 
Zapisz w chmurze
WavePad allows you to save your audio files and WavePad projects to different cloud services 
including Google Drive, Dropbox, OneDrive and SoundCloud. Audio files can be stored on any 
of the mentioned platforms while project files can only be stored on Dropbox, OneDrive and 
Google Drive. The audio files will be uploaded under the 'Apps\WavePad' folder in your 
Dropbox home. 
Using 'Upload File to Cloud Service...' option under the file menu, you can choose any of the 
above cloud services. You can then choose whether to save what you have as a Wavepad 
project or as an audio file. Then, you can navigate through the folders and type in a name for 
your file, and click on 'upload'. 
Upewnij si
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Podstawy - Prze
WavePad pozwala na przesy
Aby u
● Po zako
● WavePad otworzy przegl
● Gdy logowanie zako
● WavePad otworzy okno dialogowe, aby dostosowa
● Wybierz przycisk "Zako
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Podstawy - Eksportowanie do wideo
Utwórz wideo pliku audio za pomoc
Funkcja Eksportuj do wideo znajduje si
Ustawienia wy
Wy
● Domy
● T
● Animowany kszta
● Animowany FFT - film jest tworzony z FFT pliku audio.
● Brak obrazu t
Innych:
● Do
● Do
● Do
W
Zapisz plik jako:
● Nazwa pliku — domy
● Eksportuj folder — domy
● Format wideo — wybierz format pliku wideo. Warto
W
● Szybko
● Rozdzielczo
● Wspó
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Edycji - Konwertuj cz
Konwertuj cz
WavePad mo
Aby przekonwertowa
Aby przekonwertowa
Typowym powodem przeliczania czstawek,zobacz Ogólne poj
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Edycji - Ruch i wybór
Wybierz wszystkie(Ctrl+A2).
To select the whole file press %CTRL%A. 

Wybierz, aby rozpocz(Shift+Home).
To select from the beginning position to the current position, press %SHIFT%Home. 

Wybierz do ko(Shift+E2nd).
To select from the current position to the end, press %SHIFT%End. 

Wybierz okre
U

Przejd
U

Oznacz pierwsz
Te opcje menu Edycji mog

Wybieranie zakresów cz
Normalny wybór wybiera dwidoku spektrogramu cza nast
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Edycji - Wycinanie, kopiowanie i wklejanie
Ci(Ctrl+X2)
Aby wyci
To cut select the region and then press %CTRL%X. 
Kopii(11111CTRL%C)
Aby skopiowa
To copy select the region and then press %CTRL%C. To copy the entire file press 
%CTRL%A-C. 
Wklej(Ctrl+2V)
Wkleja
The paste function replaces the current selected region (or inserts if there is no selection). To 
replace a selection press %CTRL%V. To insert click on the position and press %CTRL%V. 
Cykl wklejania(Shift+V)
Wavepad przechowuje 10 bie

Schowek systemu
Mo

Zobacz tak
● Kopiuj do nowego
● Mieszanie pasty
● Ruch i wybór
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Edycji - Mieszanie pasty
Mieszanie pasty
Ta funkcja pobiera skopiowany lub wyci
Po wyci
Prawie zawsze d
Typowym przyk
Je
D
Mieszanie t
Ta funkcja pobiera skopiowan

Obj
Zmniejsza to g

Rozpocznij o
U funkcji Sta aby klip muzyka by

Uopcji Dostosuj wniesienie, aby uzyska

Koniec o
Na koczasu wyj aby upewni

Przed zmieszaniem uopcji Zako dostosuj bie
Uopcji Dopasuj wyj aby uzyskaDopasuj ca  aby wykonafunkcji Dopasuj czas rozpocz aby 
przycifunkcji Skró aby elegancko przycifunkcji Zanikaj t aby przyci
Zobacz teMieszanie z plikiemoraz Wycinanie, kopiowanie i wklejanie.
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Edycji - Usun
Usun(11111DELETEKEY%2)
To delete the selected region press %DELETEKEY%. This is similar to the cut function but a 
copy is not taken to the clipboard. 
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Edycji - Redact/Beep
Redact/Beep(%CTRLALT%2B)
U
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Edycji - Split
Podziel na kursor
U

Split w ciszy
U

Split w zak
Spowoduje to podzielenie pliku przy ka

Podziel na kana
Spowoduje to utworzenie jednego nowego pliku mono dla ka. Zobacz teKonwertowanie cz  
oraz ogólnych poj.

Podziel na równe cz
Spowoduje to podzielenie pliku na kawa

Dzielenie si
Biorw przybli  okre
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Edycji - Podziel na wiele cz
Z tego okna dialogowego mo
Wybieranie lokalizacji zapisywania
Mo
Podczas zapisywania na dysku w polu Lokalizacja wyj wybierz folder, w którym majNazwa wyj 
wprowad
W polu rozwijaj  wybierz format pliku, w który chcesz zapisa
Dzielenie w ciszy
Ta opcja sczasu trwania, wavepad utworzy podzia

Dzielenie w zak
U

Dzielenie na równe cz
Ta opcja s

Podzia
Podziel oryginalny plik na okreCzas trwania  i wprowadzaj

Podziel na okre
OkreIlo i wprowadzaj

Automatyczne dzielenie
Ta opcja s
WavePad postara si

Podzielone na szorstkie interwa
Podziel oryginalny plik na czRough interval i wprowadzaj

Podziel si
OkreIlo i wprowadzaj
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Edycji - Sprz
Sprz(Ctrl+J2)
Uregionów lub kilku kopii tego samego pliku. Batch Join mo
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Edycji - Do
Do
Aby poprzekonwertowa.
Aby podzieliSplit File na jego kana.
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Edycji - Zduplikowane
Zduplikowane(11111CTRL%2D)
Duplikat utworzy nowe okno pliku identyczne z bie
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Edycji - Kopiuj do nowego
Kopiuj do nowego
Aby utworzy
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Edycji - Mieszaj z plikiem
Mieszaj z plikiem
Jest to taka sama jak wklej mix, z t
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Edycji - P
P
Ta funkcja powtarza wybór kilka razy (przydatne do wyd
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Edycji - Ciszy
Wyciszy
Ta funkcja wycisza wybrany region. Ta funkcja mo

Wstaw cisz
Element menu Edycja -> Wstaw cisz

Wyciszanie przycinania
Funkcja Przytnij wyciszenia mow sekcji Przycinanie .

Cisza Szczeliny z Noise Gates
KaRedukcja szumów.
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Edycji - Przycinanie
Przycinanie(11111CTRL%T)
Aby przyci
Select the part of the file you want to keep and then press %CTRL%T. 
Przytnij pocz(11111TRIMSTART%2)
Aby usun

Koniec przyci(Ctrl+E2)
Aby usun

Automatyczne przycinanie wyciszenia od pocz
Automatyczne przycinanie usuwa cisz
Auto Trim works by scanning the region for the peak level then removing the start and end that 
is below the Auto Trim Threshold Level below the peak. The Auto Trim Threshold Level can be 
adjusted through the Tools -> %OPTIONS% -> Audio Processing tab. The default is -20 dB. 
Increase this to -15 in noisy environments. Decrease to -24 in a studio.
Ta funkcja nie b
Automatyczne przycinanie dotyczy wybranego regionu. Cz
Wyciszanie przycinania
Funkcja Przytnij wyciszenia mo
   -Próg ciszy:
   -Jest to poziom poni
   -Usu
   -Sprawd
   -Minimalna d
   -Jest to czas, w sekundach, 
   -Nowa d
   -W niektórych przypadkach mo
   -Dodaj wielokrotno
   -Jest to wielokrotno
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Edycji - Edytowanie przyk
Przyk
Przyk
Aby edytowa
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Edycji - Zapisz wybrany region jako
Zapisz wybrany region jako
Ta funkcja zapisuje wybrany region. Ta funkcja mo
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Edycji - Wstawianie pliku
Wstawianie pliku
Element menu Edycja -> Wstaw plik s
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Edycji - Bezstratna edycja MP3
Bezstratna edycja MP3
WavePad mo

Co to jest bezstratna edycja MP3?
Format MP3 jest z natury stratny: za ka

U
Prze

Ziarnisto
Wszystkie edycje w trybie edycji bezstratnej edycji MP3 musz

Zapisywanie
Aby zapisa

Opó
Niektóre pliki MP3 rozpoczynaj

Bezstratne wzmacnianie i normalizowanie
Gdy uprzed  u
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Edycji - Krzy
Krzy
Narz
● Zanikaj
● Zanikaj
● Na
Aby uEfekty -> Wybór crossfade... (NarzZanikanie przycisków pasków narztabeli Poziomy i 

 Otworzy si
(To okno ustawieCrossfade na Inne klipy.. i P)
   -Zanikanie systemu Windows
   -
● IstniejZanikanie klipuprzebiegu, a (2) dno pokazujeZanikanie w klipiePrzebiegu.
● Przebieg mo
● W lewym dolnym rogu pokazano czas wy
● W prawym dolnym rogu pokazano godzin
● W ka
● Beaty bMecz beatowyjest sprawdzana po raz pierwszy.
   -Parametry zanikania
   -Obecny zarówno fade out i fade in:
● Godzina rozpocz
● Czas trwania — d
● Typ — kszta

● Liniowy — zmiana g
● Wyk
● Sinusoidal - Zmiana g
● Logarytmiczne - Zmiana g

   -Parametry odst
   -Zanikanie i zanikanie w klipach to dwa oddzielne klipy, które zostan
● Czas trwania — odleg
● Beat match - Je
● Dopasowanie fazowe - Je
Crossfade do innego klipu
Narz
   -
   -Klip, który ma by
● Plik - klip jest osobnym plikiem.
● Wybór - klip jest cz
● Schowek - klip jest ostatnio skopiowany do schowka
   -Pozycji
   -Po
● Koniec - klip zostanie wstawiony na ko
● Pocz
● Kursor - klip zostanie wstawiony w punkcie pliku, w którym znajduje si
   -Krzy
   -Wybierz pozycj
● Zastosuj w Clip Start - crossfade zostanKoLubKursor
● Zastosuj w Clip End - crossfade zostanPoczLubKursor
● Ustawienia crossfade 
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● Zanikanie okien b
● Punkt koIZanikanie w punkcie poczzostanie zablokowany w pozycji pliku, która 

P
Zastosuj crossfade w przej
   -Liczba p
   -Czas odtwarzania/zap
   -Ustawienia crossfade
   -
● Zanikanie okien b
● Punkt koIZanikanie w punkcie poczzostanie zablokowany w pozycji pliku, która 
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Edycji - Dopasuj g
Dopasuj g
UNormalizacja d .
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Edycji - Klasyfikacja klipów
Klasyfikacja klipów
Plik audio mo
Klip audio mo
Lista wst
1. Muzyka - Jasnoniebieski
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Biblioteka d
Biblioteka d  to zbiór tysi
Po otwarciu biblioteki zobaczysz nast

Drzewo folderów
Po lewej stronie ka
Lista d
Po prawej stronie wy
Preview Sound  
Select a sound in the list then click the Play button to hear it. When you have finished, click 

. 
Download 
Select a sound in the list then click the Download button to download the sound (if it hasn't 
already been downloaded). 
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Efekty - Efekty i procesy audio
Efekty i procesy audio
WavePad jest wyposa

Wybrany region
Wi

Ustawie
Niektóre efekty s

Podgl
Wynik zastosowania niektórych efektów mo

Konwerter partii
JeBatch Converter.

Zobacz tak
● Ogólne poj
● Ruch i wybór
● Nagrywania
● Redukcja szumów
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Efekty - 

Okno dialogowe 

Dodawanie efektów do 
Lista dost

Wy
Aby dowiedzie

Stosowanie 
Aby zastosowamo cofn

Po zastosowaniu Konwerter wsadowy

Zapisywanie i 
Je

Predefiniowane ustawienia 
W dolnej cz
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Efekty - Efekty DirectX
Efekty DirectX
Ta funkcja pozwala na korzystanie z wtyczek DirectX, aby zastosowa
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Efekty - Wtyczki VST
Wtyczki VST
Ta funkcja pozwala na korzystanie z wtyczek DLL Virtual Studio Technology (VST) w celu 
zastosowania efektów do d

Efekt wtyczki VST
Po okre
Równiehttp://www.kvraudio.com, który jest kompleksowym 
Aby zobaczyhttp://www.nch.com.au/wavepad/free-vst-plugins.html .
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Efekty - Wzmocni
Wzmocni
Wzmocnienie to zwi
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Efekty - Normalizacji
Normalizacji
Aby normalizowa
Metoda normalizacji Peak znajduje próbk
Metoda normalizacji 
Metoda normalizacji Peak Loudness (RMS) próbuje normalizowa
Metoda normalizacji postrzeganej g
Metoda normalizacji zintegrowanej gEBU R-128, aby uzyska
Automatyczna normalizacja
Je
Na pasku narz

62

https://en.wikipedia.org/wiki/EBU_R_128


Efekty - Spr
Spr
Spr
Przyk
S
Okno dialogowe Spr

Karta Proste
Karta "Simple" w oknie dialogowym Spr

"Limiter" definiuje maksymalny poziom decybeli, do jakiego nagrania d
"Kompresor" zmniejsza g
Ustawienie "Stosunek" definiuje stosunek redukcji g
"Noise Gate" dzia
Mo

Karta Grafika
Na karcie "Grafika" w oknie dialogowym Spr

Aby zmieni

Zaawansowane ustawienia spr
Klikni

   -Wykrywanie poziomu wej
   -Okre
   -Odpowied
   -
   -Ataku:
   -Czas (od 0 do 1000 milisekund), który zajmie zastosowanie korekty wzmocnienia. Ca
   -Wydania:
   -Czas (od 0 do 5000 milisekund), który zajmie usuni
   -D
   -D
   -Wyprzedzenia:
   -Jak daleko do przodu (od 0 do 100 milisekund), aby spojrze
   -Korektor 
   -Okre
   -Auto Makija
   -Po wybraniu tej opcji spr

Predefiniowane ustawienia spr
Nast   -Domy

   -Naci
   -Szybka spr
   -To ustawienie kompresji spowoduje szybkie zmniejszenie liczby skoków powy
   -G
   -To ustawienie predefiniowane zmniejsza g
   -Ci
   -To ustawienie wst
   -Twardy limit:
   -To ustawienie wst
   -Mi
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   -Ten limit pozwala na krótkie skoki powy
   -Brama ha
   -Spowoduje to usuni
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Efekty - Korektora
Korektora
Korektor zmienia odpowied
Po wybraniu menu Efekty -> Korektor zostanie wy
Korektor wizualny  
Left click on dowolny punkt, aby utworzy
Korektor graficzny 
Korektor graficzny u
Korektor parametryczny  
Korektor parametryczny jest podobny do korektora graficznego, ale z wi
   -Filtr przebiegu paska
   -Utrzymuje tylko te cz    -Cz
   -Dolna warto
   -Cz
   -Górna warto
   -D
   -Szeroko
   -Amplitudy
   -Stopie
   -Filtr zatrzymania/ci
   -Zachowuje wszystkie cz
   -Cz
   -Ni
   -Cz
   -Górna cz
   -D
   -Szeroko
   -Odrzucenia
   -Stopie
   -Filtr wysokiego przej
   -Utrzymuje tylko te cz
   -Cz
   -Punkt, w którym wszystkie powy
   -D
   -Szeroko
   -Filtr dolnaprzepustowy
   -Utrzymuje tylko te cz
   -Cz
   -Punkt, w którym wszystkie poni
   -D
   -Szeroko
   -Filtr wyci
   -Przys
   -Cz
   -Dolna warto
   -Cz
   -Górna warto
   -Filtr do
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   -Albo atuuje lub zwi
   -Cz
   -Ni
   -Cz
   -Górna warto
   -D
   -Szeroko
   -Amplitudy
   -Stopie
   -Filtr pó
   -Atenizuje sygna
   -Cz
   -Ni
   -Nachylenie
   -Szeroko
   -Odrzucenia
   -Stopie
   -Filtr pó
   -Atenizuje sygna
   -Cz
   -Ni
   -Nachylenie
   -Szeroko
   -Odrzucenia
   -Stopie
Je
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Efekty - Koperta
Koperta
Koperta to zmiana g
Zaznacz region, w który chcesz zmieni
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Efekty - Patelnia stereo
Patelnia stereo
Efekt stereoskopowy pozwala zmieni
Wybierz region, dla którego chcesz zmieni
Nale
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Efekty - Echo
Echo
Echo jest powtórzeniem d
Aby doda
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Efekty - Pog
Pog
Pog

Proste
Pierwsza zak
Karta Proste zawiera równie
Projekt pokoju
Druga zak
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Efekty - Phaser
Phaser
Efekt d
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Efekty - Flanger
Flanger
Efekt d
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Efekty - Vibrato
Vibrato
Efekt d

73



Efekty - Tremolo
Tremolo
Efekt d
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Efekty - Doppler
Doppler
Efekt dopplera symuluje d
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Efekty - Wah-Wah
Wah-Wah
Jak sama nazwa wskazuje, efekt moduluje okre
Rezonans: znany równie
G
Cz
Cz
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Efekty - Chór
Chór
Efekt d
Uwaga: Chorus jest bardzo przydatnym sposobem, aby d
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Efekty - Zniekszta
Zniekszta
Podczas gdy zwykle robimy wszystko, aby zmniejszy
Aby uzyska

78



Efekty - Efekt radiowy AM
AM Radio
To symuluje AM Radio. Zrobili
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Efekty - Efekt telefoniczny
Telefon
Symuluje d
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Efekty - Odwróci
Odwróci
Ten efekt odwraca zaznaczenie w taki sam sposób, jak odtwarzanie rekordu lub ta
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Efekty - Blakni
Zanikanie
Aby zanika

Zanikanie
Aby znikn

Zanikanie i przycinanie
Opcja zanikania i przycinania jest funkcj

Krzy
Narz
● Zanikaj
● Zanikaj
● Na
Aby u
Wykres jest podzielony na dwie sekcje, górna sekcja pokazuje blakni
Po najechaniu kursorem myszy na dowoln
Pola danych dzia
   -Pocz
   -Informuje o godzinach rozpoczUwaga:Te czasy NIE odpowiadaj
   -Czas przerwy
   -To mówi, jak dUwaga:Je
   -Zanikanie w czasie
   -Czas zanikania na ko
   -Zanika
   -Czas zanikania pocz
   -Typ zanikania
   -Kszta
● Liniowy — zmiana g
● Wyk
● Sinusoidal - Zmiana g
● Logarytmiczne — zmiana g
Tak wi
1. Bufor zanikania zostanie utworzony z d
2. Bufor fade-in zostanie utworzony z d
3. Bufory Fade-In i Fade-Out zostan
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Efekty - Zmiana pr
Prosta zmiana pr
To odtwarza nagrywanie szybciej lub wolniej, co z kolei zwi

Zmiana pr
Normalna zmiana pr

Zmiana wysoko
Zmienia to wysoko

Profil pr
Dzi
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Efekty - Zmniejsz wokal
Zmniejsz wokal
Je
1. U  Ta metoda wykorzystuje model uczenia maszynowego do automatycznego szacowania 

wokalu w danym d
2. U  

Ta metoda b
3. Usuwanie d 

Ta opcja dzia
Uwaga: nie da si
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Efekty - Efekt anonimowy
Efekt anonimowy
U
Naci
U
Uwaga: Ten efekt mo
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Efekty - Zmiana g
Zmiana g
The Voice Changer umo
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Oczyszczanie d
Istniej
Czasami przy u
   -Odejmowanie spektralne
   -   -Metoda automatyczna
   -Takie podej
   -Metoda r
   -Aby z niej korzysta
1. Wybierz krótk
2. Wybierz opcj
3. Zaznacz ca
4. Wybierz opcj
   -Wielopasmowa brama ha
   -Wielopasmowa brama szumów usuwa wszystkie dane audio poni
Brama ha
Brama szumu to filtr, który steruje g
   -Próg
   -D
   -Przytrzymaj
   -Okres czasu (w milisekundach) do oczekiwania przed zastosowaniem t
   -Wydania
   -Okres czasu (w milisekundach) wzi
   -Ataku
   -Okres czasu (w milisekundach) wzi
   -T
   -Kwota do t
Kreator usuwania szumów
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Oczyszczanie d
Automatyczne klikanie/usuwanie popu
To narz

Parametryczne usuwanie klikni
To narz
Aby u
   -Kliknij czu
   -Jest to stopie
   -Maksymalna d
   -Jest to maksymalna d
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Oczyszczanie d
Filtr wysokoprzebiegowy
Filtr wysokoprzebiegowy (czasami nazywany filtrem o niskim kroju) usuwa wszystkie niskie cz
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Oczyszczanie d
Filtr dolnych
Filtr dolnych usuwa wszystkie wysokie cz
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Oczyszczanie d
Automatyczna kontrola wzmocnienia
Automatycznie dostosowuje amplitud
De-esser jest stosowany, aby unikn
Filtr wysokoprzepuszczowy jest stosowany, aby unikn
AGC jest najcenniejszy w Batch Converter, gdzie chcesz, aby wiele nagra
Inne funkcje, które mog
● Normalizacja  – zmienia poziom ca
● Spr – natychmiastowa regulacja g
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Oczyszczanie d
Korekcja przesuni
Cz
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Oczyszczanie d
De-esser (de-esser)
Zmniejsz nadmierne wyeksponowanie spó
Aby u
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Narz
Analiza cz
To narz
W prawym górnym rogu znajduj
Dwa typy okien, Hanning i Hamming, s
Aby wy
Aby powi
Alternatyw
Bie
Analiza cz
To narz
Je
Aby wy
Suwak umo
Je
Mo
Je
Bie
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Narz
Zamiana tekstu na mow
To narz
Ta funkcja wymaga aparatu mowy, który nie jest zainstalowany na wszystkich komputerach. 
Aby pobrawww.nch.com.au/speech.
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Narz
Nawigacja po mowie
Okno dialogowe Nawiguj mowa u
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Narz
Konwerter partii jest u
Otwórz konwerter partii za pomoc
Krok 1: Wybierz pliki
Click on przycisku Dodaj i przejd
Click Next po dodaniu wszystkich plików.
Krok 2: Wybierz polecenia
Dla ka
Mo
Aby zapisa
Krok 3: Wybierz format wyj
Domy
Uwaga: je
Pliki s
Zobacz tak
Efekty
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Narz
Wybieranie klipu audio  
Otwórz d
Wybierz docelowy typ telefonu  
● Wybierz iPhone - typ dzwonka to m4r.
● Wybierz telefony z systemem Android - typ dzwonka to mp3.
● Wybierz inne - typ dzwonka to mp3.
Wprowadzanie wiadomo 
Wpisz adres e-mail u
Tworzenie dzwonka i wysy  
Ten krok mo

98



Narz
Pobierz z biblioteki d
WavePad daje dostbiblioteki d zawieraj
Podgl
WavePad Master's Edition jest wyposa
Uwaga: Aby wy
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Narz
Edytor d
Edytor d
Poni
   -Wy
   -G
   -Lista plików:
   -Wszystkie aktualnie otwarte pliki audio s
   -Utwory d
   -Wszystkie 
   -G
   -G
   -G
   -G
   -Wska
   -D
   -Koperty pan:
   -Przesu
   -Rozmycie przestrzenne:
   -Rozmycie przestrzenne jest parametrem, który steruje rozk
   -Waga g
   -Domy
Poni
   -Dodaj g
   -Click on przycisku Dodaj.
   -Dodaj g
   -Click on przycisku Dodaj LFE.
   -Usuwanie g
   -Wybierz g
   -Wybierz predefiniowane konfiguracje g
   -Wybierz konfiguracj
   -Dodaj/Usu
   -Zaznaczanie/usuwanie zaznaczenia 
   -Zmie
   -Kliknij lewym przyciskiem myszy i przeci  ikon
   -Przypisywanie 
   -Przeci
   -Zmie
   -Wybierz g
   -Zmie
   -Wybierz 
   -W
   -Zaznacz pole wyboru 
   -Sterowanie ruchomym efektem d
   -Wybierz Kliknij lewym przyciskiem myszy i przeci  tworzy nowe punkty ikliknij prawym 
przyciskiem myszy usuwa punkt. Click on czerwony kursor i przeci
   -Zapisywanie danych wyj
   -Po umieszczeniu 
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Narz
Znalazce szczytów
To narz
Poni
● Bezwzgl- aby znale
● Rms- aby znaleOkno RMS(w milisekundach) to dNak(w procentach) jest to, jak daleko 

okno RMS jest przesuni
Poni
● Ustawianie kursora na najbli
● Oznaczanie wszystkich szczytów zak
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Narz
Wykrywanie uderze
Automatyczne wykrywanie uderze
Wykryte uderzenia s
Uwaga:Ten proces mo
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Options2 - Options2
Otwórz wavepad Options Dialog Box za pomoc
Uwaga.: Windows 8 i po NIE maj. Je
● Ogólne
● Audio
● Nagrywania
● Wygl
● Myszy
● Odtwarzania
● Klawisze i makra
● Typy plików
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Options2 - Ogólne
Podczas tworzenia nowego pliku
Monituj o cz
Wybierz t
U
Wybierz tOgólne poj

Podczas zapisywania pliku
Monituj o ustawienia formatu pliku
Wybierz opcj
● Prompt Always - WavePad monituje o ka
● Monituj o pierwsze zapisanie pliku - (dost
● Nigdy nie monituj - WavePad u
Menu kontekstowe
Dodawanie wavepada do menu kontekstowego Eksploratora plików 
Wybierz t
Domy
To pole s
W domy
● 11111utonumber% - auto wzrost liczby
● %YYYY% - current rok
● %MM% - c2urrent miesi
● %DD% - current dzie
● %HH% - current godz.
● %MIN% - current minut
● %SS22222urrent drugi
Przycisk "Reset" zresetuje format do formatu domy
Przycisk Resetuj automatyczny numer resetuje nast%autonumber%22 do 0.
Adres e-mail
Niektóre operacje w WavePad mogKonfiguruj ustawienia poczty e-mail...
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Options2 - Audio
Urz
W tym miejscu wybierasz urz
Je
Aby uzyskaurz  slub godwiedstron

Ostrze
Otrzymuuj powiadomienia o mo

Próg automatycznego przycinania
To ustawienie ma zastosowanie do funkcji Automatyczne przycinanie i przycinanie wyciszania,

Folder roboczy audio
Gdy WavePad 
Uwaga: Jest to folder tymczasowy i nie powinien by
Przechowywanie plików pami — ustaw, jak d
● Smart Max 28 dni - Pliki starsze ni
● Smart Max 14 dni - Pliki starsze ni
● Usu
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Options2 - Nagrywania
Urz
W tym miejscu mo
Lista Wej
Poni
Nale
   -U
   -Spowoduje to zmian
   -Poziomy wy
   -Umo
Aby uzyskaWavePad Zalecane mikrofony.

Automatyczne nagrywanie
   -Automatyczne przycinanie wyciszenia od ko
   -Spowoduje to usuni
   -Nagrywanie aktywowane g
   -Po aktywacji nagrywanie rozpocznie si
   -Opó
   -Spowoduje to dostosowanie d
   -Próg ciszy:
   -Jest to u
Zak
Zezwalaj na dodawanie zak
Zobacz teNagrywanie.
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Options2 - Vsts
Wtyczki VST
W tym miejscu nale
Poszczególne foldery mo
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Options2 - Wygl
Options2
Automatyczne rozmieszczanie okien plików tak, aby by 
Wybierz t
Maksymalizuj nowo otwarte okna plików, je 
Wybierz t
Poka 
Zaznacz t
Domy 
Wybierz t
Poka 
Wybierz t
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Options2 - Myszy
Myszy
Opcje powi 
Powi
Wybierz t
Powi
Wybierz t
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Options2 - Odtwarzania
Odtwarzanie Options
Automatyczne odtwarzanie pliku po otwarciu
Wybierz t
Automatyczne odtwarzanie po dowolnej edycji lub efekt
Wybierz t
Automatyczne odtwarzanie pliku po przej
Wybierz t
Automatyczne odtwarzanie pliku po wybraniu regionu
Wybierz t
Zmniejsz g
Wybierz t
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Options2 - Klawisze i makra
Je
Aby utworzy
1. Otwórz wavepad Options -> Klawisze.
2. Kliknij przycisk Dodaj.
3. Naci
4. Kliknij przycisk Dodaj, aby doda
5. Wybierz polecenia.
6. Kliknij przycisk OK.
Od tego czasu za ka
Je
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Options2 - Typy plików
U
● U  Wybierz z tej listy typy plików, które chcesz otworzy
● Korzystanie z Panelu sterowania systemu operacyjnego Windows -> Programy domy 
Uwaga.: Windows 8 i po NIE maj. Je
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Options2 - Nagrywanie metronomu
Nagrywanie metronomu
WavePad ma wbudowany metronom, który b

Dostosowywanie bpm i podpisu czasu
Sygnatur

Wybieranie niestandardowego d
Zaznacz to pole wyboru, je
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Options2 - Opcje widoku
Opcje widoku
Opcje dostosowywania obszaru roboczego w celu uzyskania lepszego dzia
Pasek polece  — pasek polece
Powi — zmiana z d
Opcje okna wave:
Widok domy  — przywracanie wy
Tryb edycji próbki — umo
Display + W gór - 
Wy — wy
Kana — lewe i prawe kana
Oddzielna edycja kana  — umo
Spektogram cz — poka
Logarytmiczne spektogram cz  - Poka
Wy - Poka
Unikalne kolory kana - (dost
Kolor wed  - Poka
Kolorowy edytowany klip  — pokazywanie zmian klipu audio wed
Poka  - Poka
Poka  - Poka
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Formaty wyj
W WavePad, wi
Formaty z konfigurowalnymi opcjami:
● Wav
● Mp3
● Vox / Surowy
● Mpc
● Ape
● Spx
● Aif / Aiff / Aifc
● Au
● Flac
● AAC / M4A / MP4
● Dct
● Ogg
● Amr
● Wma
● MP1 / MP2
● Listy odtwarzania RSS
● Listy odtwarzania M3U
● Listy odtwarzania PLS
● Listy odtwarzania WPL
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Formaty wyj
Nazwa
Ta lista rozwijana umo
Mo
Formacie
To ustawienie umo

Atrybuty
To ustawienie umo
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Formaty wyj
Kodowanie sta
Wybierz t
Opcja pola wyboru "Wysoka jako
Kodowanie zmiennej szybko
Wybierz t
Opcja "Jako
Uwaga: W zale
Kana
To wybiera, czy plik MP3 b
Uwaga: JeTo nie jest b
Ochrona przed b
Ta opcja dodaje dodatkowe informacje CRC do pliku MP3 i chroni przed ma
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Formaty wyj
Formacie
Wybierz format danych pliku z listy rozwijanej.

Przyk
Wybierz cz

Kana
Wybierz liczb
Nale
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Formaty wyj
Kodowanie jako
Wybierz t

Kodowanie zmiennej szybko
Wybierz t
Uwaga: W zale
Kana
Wybiera, czy plik wyj
Uwaga: JeTo nie jest b
Odrzu
Oznacza to, czy odrzuci
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Formaty wyj
Poziom kompresji
Ta opcja okre

Cz
W tym miejscu mo

Kana
Wybiera, czy plik wyj
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Formaty wyj
Kodowanie 
Wybierz t

Kodowanie zmiennej szybko
Wybierz t

Opcje zaawansowane
Pole opcji zaawansowanych daje wybór opcji kodowania, które nie s

Opcje zaawansowane - wymu
Wymusza kodowanie przy u

Opcje zaawansowane — wy
Wy
Uwaga: Opcja wyboru wyj
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Formaty wyj
AMR Narrowband jest popularnym formatem u
Jedynym ustawieniem do okre

122



Formaty wyj
Podcast to utworzony plik audio, który mo
● Plik RSS: jest to plik, który b
● Plik MP3: jest to rzeczywiste nagranie audio. Zostanie pobrany tylko przez programy 

podcastowe na 
Aby tworzy
Okno dialogowe ustawie
G — adres URL, w którym zostanie przes
Ustawienia MP3 - Kliknij przycisk "Ustawienia MP3", aby otworzyMP3).
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Formaty wyj
Lista odtwarzania M3U to plik tekstowy zawieraj
W WavePad obs
● Plik M3U: plik odtwarzany w WinAmp.
● PLIK MP3: plik zawieraj
Aby utworzy
Okno dialogowe ustawie
G
Adres URL, pod którym mo
   -Bezwzgl
   -Po utworzeniu pliku M3U z bezwzgl
   -Standardowy adres URL http
   -nphttp://www.music.com/
   -Adres URL pliku na komputerze lokalnym
   -np.
   -Wzgl
   -Pliki M3U musz
   -Wzgl
   -na przyk
   -Wzgl
   -na przyk
Ustawienia MP3
Kliknij przycisk "Ustawienia MP3", aby otworzyMP3).
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Formaty wyj
Pliki PLS to pliki tekstowe zawieraj
W WavePad obs
● Plik PLS: plik, który odtwarzasz w WinAmp.
● PLIK MP3: plik zawieraj
Aby utworzy
Okno dialogowe ustawie
G
Adres URL, pod którym mo
   -Bezwzgl
   -Po utworzeniu plików PLS z absolutnymi adresami URL, mo
● Standardowy adres URL http np http://www.music.com/.
● Adres URL pliku na komputerze lokalnym np.
   -Wzgl
   -Pliki PLS musz
● W stosunku do folderu g
● W stosunku do katalogu np.
Ustawienia MP3
Kliknij przycisk "Ustawienia MP3", aby otworzyMP3).

125

mp3_settings.html


Formaty wyj
Pliki WPL to pliki tekstowe zawieraj
W WavePad obs
● Plik WPL: plik odtwarzany w programie Windows Media Player.
● PLIK MP3: plik zawieraj
Aby utworzy
Okno dialogowe ustawie
G
Adres URL, pod którym mo
   -Bezwzgl
   -Po utworzeniu plików WPL z absolutnymi adresami URL, mo
● Standardowy adres URL http np http://www.music.com/.
● Adres URL pliku na komputerze lokalnym np.
   -Wzgl
   -Pliki WPL musz
● W stosunku do folderu g
● W stosunku do katalogu np.
Ustawienia MP3
Kliknij przycisk "Ustawienia MP3", aby otworzyMP3.
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Zaawansowane - Opcje wiersza polecenia
Uwaga: Ta funkcja jest dost
You can easily control WavePad from the command line. The WavePad executable is usually 
located at "C:\Program Files\NCH Software\WavePad\wavepad.exe". The usage of 
command-line is:
Uwavepad.exe[opcje] [pliki do edycji] 
OPCJE:  to miejsce, w którym mo
   --zapisz
   -Zapisz bie
   --saveas<filepath>
   -Zapisz bie
   --play
   -Odtwarza aktualnie aktywny plik.
   --rekord
   -Nagrywanie d
   --stop
   -Zatrzymuje aktualnie odtwarzany plik.
   --restart
   -Ustawia kursor na pocz
   --zamknij
   -Zamknij bie
   --wyj
   -Wyjd
   --zminimalizowa
   -Zminimalizuj okno WavePad do ikony w zasobniku systemowym .
   --maksymalizuj
   -Maksymalizuj okno WavePad pasuje do pe
   --przywracanie
   -Je
   --okno <width> <height> </width>
   -Ustaw szeroko
   --list [listfilepath]
   -ListFilePath to plik tekstowy zawieraj
   --partia
   -   --batch [
   -Dodaj okre
   --batch -inpdir [folderpath] [
   -Opcja -inpdir dodaje pliki z folderu i jego podfolderów rekursywnie. Gdzie [folderpath] jest pe
   --batch [scriptfilepath] -inpdir [folderpath] [
   -[scriptfilepath] to plik skryptu, który zawiera wszystkie polecenia, które zosta
   --batch [scriptfilepath] -inpdir [folderpath] [
   --destdir okre
   --batch [scriptfilepath] -inpdir [folderpath] [
   -Opcja -output okre
   --batch [scriptfilepath] -inpdir [folderpath] [
   -Opcja -run wykonuje polecenie konwersji wsadowej. Spowoduje to wyj
   --batch [scriptfilepath] -inpdir [folderpath] [
   -Opcja -quit wykonuje konwersj
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   -FILEs DO EDYCJI:
   -Gdzie wpisujesz pliki, które chcesz za
Przyk
wavepad.exe -save -close
wavepad.exe -saveas "C:\Moja muzyka\MyNewFile.mp3" -exit
wavepad.exe -minimalizuj
wavepad.exe -maksymalizuj
wavepad.exe -restore
wavepad.exe -okno 800 600
wavepad.exe -batch "C:\Moja muzyka\MyNewFile.mp3"
wavepad.exe -batch -inpdir "C:\MusicFolder" "C:\Moja muzyka\MyNewFile.mp3"
wavepad.exe -batch -inpdir "C:\MusicFolder" "C:\Moja muzyka\MyNewFile.mp3" skrypt.wpb
wavepad.exe -batch -inpdir "C:\MusicFolder" script.wpb -destdir "C:\Convert" -output .wav -run
wavepad.exe -batch "C:\Moja muzyka\MyNewFile.mp3" -destdir "C:\Convert" -output .wav -quit
wavepad.exe -list "C:\Moja muzyka\MyFileList.txt"
wavepad.exe "C:\Moje projekty\WavePadProject.wpp"
wavepad.exe "C:\Moja muzyka\Muzyka1.wav" "C:\Moja muzyka\Music1.mp3"
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Suite - Zalecane programy
Ponistronie audio programu NCH Software.
● Mikspad Mieszanie wielu - Mieszaj nieograniczon
● SoundTap Streaming Audio Recorder- Nagrywanie prawie ka
● Zmieniacz g- Najnowocze
● Zulu DJ Oprogramowanie- B
● Ekspresowe nagrywanie p- Tworzenie i nagrywanie p
● Ekspresowy rip CD Ripper- Wyodr
● Prze- Konwertuj i koduj pliki audio mi
● Golden Records Konwerter analogowy na CD/MP3- Konwertuj rekordy LP i kasety audio 

na p
● Edytor wideo VideoPad- Tworzenie, edytowanie i konwertowanie profesjonalnych filmów 

wysokiej jako
● Oprogramowanie do generatora tonów ToneGen- Generowanie sinusoidy, cz
● Oprogramowanie do notacji muzycznej Crescendo- Tworzenie profesjonalnych partytur 

muzycznych dla pojedynczych lub wielu instrumentów.
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Rozwi
Poni
● Sterownik karty d
● Niezgodne ulepszenia d
● Ustawienia kana
Sterownik karty d
Aby zaktualizowa
● Otwórz MenedKlawisz Systemu Windows+R, a nastDevmgmt.msc)
● Kliknij dwukrotnieKontrolery d . Karta d
● Kliknij prawym przyciskiem myszy kartAktualizacja sterownika . System Windows 

poprowadzi Ci
Niezgodne ulepszenia d
Firmy Microsoft i dostawcy zewn
● Otwórz przycisk dKlawisz Systemu Windows+R, a nastmmsys.cpl)
● PrzejdNagrywaniaZak
● Kliknij prawym przyciskiem myszy urzW.
● PrzejdZaawansowane i odznaczW
● KliknijZastosowaPrzycisk
Ustawienia kana
Urzkliknij tutaj.
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Rozwi
Poni
● Sterownik urz
● Urz
● Urz
● G
Sterownik urz
Aby zaktualizowa
● Otwórz MenedWindows+X , a nast
● Kliknij dwukrotnie Kontrolery d . Urz
● Kliknij prawym przyciskiem myszy urzAktualizacja sterownika . System Windows 

poprowadzi Ci
Urz
Aby w
● Otwórz MenedWindows+X , a nast
● Kliknij dwukrotnie Kontrolery d . Urz
● Kliknij prawym przyciskiem myszy urzW.
Urz
Port, do którego pod
● Urz Niektóre komputery maj
● Z Sprawd
● Wymagany port mo Sprawd
G
Aby wyregulowa
● Znajd
● Upewnij si
● Aby zwi
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Odwo
To okno dialogowe umo
W oknie dialogowym Rozwi
JeZachowaj wspó jest dost
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Odwo
To okno dialogowe umo
W oknie dialogowym Rozwi
Szeroko
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Odwo
To okno dialogowe umo
W oknie dialogowym Niestandardowa liczba klatek na sekund
Domyzmienna liczba klatek na sekund ale w oknie dialogowym moopcj zaznaczajSta
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Odwo
W tym oknie dialogowym pokazano wykryty format sekwencji wideo podczas procesu 
zapisywania. Aby wykry
Kliknij przycisk Wykryj obok pola Predefiniowane. Detect dostosuje format rozdzielczo
Je
Kliknij przycisk OK, aby u
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Odwo
Wybieranie strumienia audio Strumie
Wybieranie strumienia audio z pliku
Nie pytaj mnie ponownie
Pomijanie okna dialogowego wyskakuj
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